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1.  before you start 
 
I find the best time to prepare the order of service is the previous Wednesday evening.  
This is early enough to meet the Thursday-morning copying deadline, which is convenient 
for Gary Goodman (see 5. contacts), and late enough for last-minute notices to be 
included.   
 
Typically an order of service has to be prepared every week, but extra ones are 
sometimes needed for special services at Christmas and during Holy Week.    
 
You’ll need the following items of information to complete the order of service: 

1. A draft order of service from whoever is leading worship, including running order, 
hymn numbers, and Bible readings (ideally with page numbers from the pew 
Bibles).  If the minister wants to include any liturgy, for example Communion 
responses, this too should be included in the draft order. 

2. Details of events in the church calendar, e.g. Scottish country dancing and the art 
group.  I find the best reference for these is the excellent Dates for Your Diary 
supplement which Susan Giddons (see 5. contacts) includes in Cornerstone, the 
church magazine, which is also available on the Scots Kirk website.  During holiday 
times, most of these events are suspended.  Susan’s calendar also includes the 
following regular events, all of which should be mentioned in the order of service 
when appropriate: 

o Holy Communion on the first Sunday of every month, and special Sundays 
such as Easter, Christmas, and Pentecost. 

o Potluck lunch in the church hall on the first Sunday of every month. This 
should be mentioned in the last OoS of the previous month, to give 
people an opportunity to prepare food, e.g. "after the service – potluck lunch. 
Bring some food to share, but there's enough to go round even if you don't." 
Also note that the standard reference to tea & coffee in the church hall 
after the service should be omitted on potluck (Communion) Sundays. 

o Soup & cheese lunch in the fellowship centre on the first Wednesday of 
every month. 

3. Details of events and information which are not in the church calendar.  Typically 
these are emails including information about Sunday school, Bible study, Kirk 
session meetings, and so on.  I will ensure that the people who send these emails 
check the order-of-service rota on the Scots Kirk website, so they know who to 
inform. 

 
A good way to see how these events come together is to look at old copies of the order of 
service, which can be found on the Scots Kirk website, under Church Notices in the menu 
on the left, then Orders of Service1. 

                                                
1 http://www.scotskirklausanne.ch/?q=node/76 retrieved 7 August 2012 
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2.  preparing the order of service 
 
As you would expect, the best place to start is with the previous week’s order of service.  
Download it from the Scots Kirk website, under Church Notices in the menu on the left, 
then Orders of Service2. 
 
Edit the name of the file appropriately.  The current format makes it a little harder to find 
the order of service on a PC, but it’s easier for website browsers.  Having two different 
names for the same file in different places would be confusing, I think. 
 
Now open the file in Word.  Page 1 never changes, so focus on the service order (pages 
2-3) and the church notices (page 4). 
 
 
2.1.  pages 2-3: service order 
 

1. If Ian has prepared the draft, it’s unlikely you’ll have to do much beside cutting & 
pasting.  Try to fill pages 2-3 evenly by increasing the font size or spacing if 
necessary.  A good place to make the page break is often when the children go out 
to Sunday school. 

2. Change the date at the top of the page. 
3. Amend the Sunday in the Christian calendar.  I find an online Christian calendar3 

to be helpful here.  After Pentecost/Trinity, nothing much changes until Advent. 
4. Be careful when copy-pasting hymns and Bible readings from the minister’s draft 

order.  If you’re not careful, you can end up picking up different tab settings, making 
it harder to line up all the numbers and titles.  You may of course be thinking that 
life’s too short for lining up numbers and titles, and you’re probably right.  But mine 
isn’t! 

5. Some ministers include hymn tunes, some don’t.  If you’re not given the hymn tune, 
just leave the end of the line blank. 

6. Some ministers include Bible page numbers, some don’t.  If you’re not given the 
page number, just leave the end of the line blank (unless you happen to have a pew 
Bible handy and can find this yourself).    

7. If you look carefully at a few old orders of service you’ll see that I’ve tried to 
standardise fonts, spacing, typefaces, etc.  There are many more important things 
in life than these, so don’t worry about them too much.  But if the appearance of the 
order of service is too inconsistent, people might have trouble reading it.  I think at 
least a little attention to detail is justified. 

8. Some ministers have more items in the service order, some have less.  If there are 
many items to include, you may have to remove a few blank spaces here and there, 
or even one of the permanent notices on page 3, to squeeze everything onto one 
page.  Don’t reduce the font size if you can possibly avoid it.  I’ve never had to do 
that. 

                                                
2 http://www.scotskirklausanne.ch/?q=node/76 retrieved 7 August 2012 
3 http://www.christianitysite.com/calendar.htm retrieved 7 August 2012 
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2.2  page 4: church notices 
 

1. Today’s worship leader.  If Ian is away, I usually try to put in a few words of 
welcome and a very short biography (minister, interim moderator, or even Google 
can provide this).  If someone stays for a few weeks (e.g. Dave Robinson), I think it 
helps to give the congregation some warning as to when his/her last Sunday will be.  
People like to say goodbye and might not be here on the guest minister’s last 
Sunday. 

2. Most of the items on this page come straight out of Cornerstone’s Dates for Your 
Diary. 

3. Some items come from emails.  I encourage people to send emails because it 
makes them think about how their message will be worded.  When someone comes 
up to me and asks, “Could you just put something in the order of service about…?” 
my heart sinks.  When the time comes to write the message you never know what 
the person really wants to say, and it takes time and more communication to get it 
right.  Ask people to email their notices and they are the ones who do the drafting, 
saying exactly what they want to.  Then it’s just a copy/paste job from the email. 

4. What to include and when: always include at least one more Sunday service, so 
people know what to expect the following week.  On the other hand, I usually don’t 
include anything until it’s less than a month away.  

5. Important events, e.g. the church bazaar: I’ve used a 1x1 cell table to draw people’s 
attention to such events.  I’ve also experimented with shaded tables and fancy 
borders for the tables.  Both experiments failed, because the greyscale didn’t 
photocopy well and another Word installation didn’t support the unusual border, 
respectively.  Keep it simple. 

6. Vertical spacing:  the best way to do this is with Word’s paragraph spacing 
function, not carriage returns.  I use a 6-point gap between each day in the 
calendar, as you can see by examining any previous order of service.  In summer, 
there will be little to report on page 4, but it gets busy again before Christmas.  It 
may be necessary to change to a condensed font or to reduce the vertical spacing a 
little. 

7. Try to leave some space for the Scots Kirk’s bank details at the bottom of the page.  
The font size is always smaller than for the rest of the notices, but you can shrink it 
even more if that’s the difference between squeezing in all the notices and not.  If 
there really isn’t enough space, remove the bank details stuff.  Whoever does the 
OoS the following week can paste it back in.  So at least check the bank details are 
there, just in case they were removed the previous week. 

 
 
 
2.3  page 1: title page 
 
Never changes. 
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3.  updating the website 
 
Once the order of service is complete, it has to be posted on the Scots Kirk website.  At 
the same time, the church notices need to be copied and pasted from the order of 
service to the relevant page on the website. 
 
Detailed instructions follow, which will take a while to carry out the first couple of times.  
But after you’ve done it a few times it doesn’t take long at all. 
 
Follow these steps: 
 
1. Go to the Scots Kirk website4 and click on enter.  You’ll see a screen that looks like 

this: 

 
 

                                                
4 http://www.scotskirklausanne.ch/  retrieved 3 June 2011 
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2. Click on Login at the bottom of the screen.  Enter username Ross and password 

Melvyn.  Click on Log in. 

  
 
3. Now click on Church Notices and then Orders of Service in the menu on the left of 

the screen.  The page shows the last few orders of service, with the most recent at the 
top. 

 
 
4. Now click on the Edit tab in the top centre of the screen, allowing you to make 

changes to the page.  The new order of service has to be uploaded.  So scroll down to 
the bottom of the page to the Attach new file section.   
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5. Click on Choose File, then browse for the order of service document you’ve already 
prepared: 

 
Choose the right file.  Then click the Attach button.  After a few seconds (depending on 
how fast your internet connection is), the file you selected will be added at the bottom of 
the list of orders of service. 
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6. The latest order of service should be at the top of the list, so you need to drag and drop 

it there.  To the left of each order of service is a four-way-arrow symbol.  Drag this 
symbol to the top of the list and drop it there.  If you wish to remove any of the orders 
of service from the page, check the delete box for the right one: 

 
 
7. Finally, click the Save button at the bottom of the page, to see the new order of service 

at the top of the list: 
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8. All that remains now is to copy and paste the church notices from page 4 of the order 

of service into the relevant page on the website.  Once again, you have to click 
Church Notices in the menu on the left of the screen. 

 
 
9. As before, click on the Edit tab in the top centre of the screen.  The key section is the 

Body pane in the middle of the page: 

 
This is what has to be changed. 
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10. Editing the church notices directly on the internet page should be avoided as much as 

possible, because the editing tool produces unpredictable results.   
Also note that you should not put anyone’s email address onto the site.  They are 
picked up by robots and then used to spam the owner.  If you have to put an email 
address up then please save it as an image (.jpg is best) and post that up.  Or use 
<at> instead of @. 
When updating the Church notices, to avoid unwanted formatting characters, always 
use the “Paste from Word” button (on the right on the tool bar of the editing window) to 
paste.   
Start by copying the notices from page 4 of the order of service (calendar entries only, 
starting with today): 
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11. The notices will be posted two days in advance of the service, so references to “today” 

must be changed to the following Sunday in the new document.  Also remove 
references to “pick up Cornerstone”. 

 
 
12. Now copy and paste the contents of the new document into the Body pane.  Paste 

over everything that’s there already.  
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For reasons I don’t understand, the text formatting is changed in various ways after it 
has been pasted into the Body pane.  The good news is there’s an easy fix for this. 
First, cut all the text you’ve just pasted into the Body pane and paste it into the Paste 
from Word window.  

 
 

 
Now use the right arrow key a few times to get to the end of any invisible text in the 
Body pane, before hitting the delete key a few times to remove any invisible formatting 
characters.  Finally, hit the Insert button, to copy the text back into the Body pane.    
Click on the Preview button at the bottom of the screen to check that there are no 
unwanted carriage returns in the text. 
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If all has gone according to plan there should be no unwanted carriage returns.  If not, 
or if you pasted directly into the Body pane without using the Paste from Word tool, you 
now have to fix the formatting changes.   Click on the Preview button below the Body 
pane to see what the text will look like after it has been saved.  Notice how two things 
have changed: 1 – the date headings don’t have the right font, and 2 – extra carriage 
returns are included, seemingly at random, throughout the text. 

 
 
13. I find it helpful to make a print of the preview version so as I don’t have to keep 

switching back and forward between Preview and Body panes.  Scroll down to the 
Body pane again.   
Please note that style-wise, days are in Heading 3 and all other text is in Paragraph 
style.  The event times and title should be in Paragraph Bold.  To fix the formatting of 
the date headings, highlight each one with a triple click, and then select Heading 3 
from the Format menu at the top of the Body pane.  Repeat for each date in the 
calendar then check by clicking Preview again. 
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14. Ignore this step if Preview shows no unwanted carriage returns.   
Now remove the random? carriage returns.  You’ll find it easier to do this if you refer to 
the paper print you made earlier.  For example, in the screenshot below, three carriage 
returns have to be removed:  on 21 June, between Scottish & country, and on 22 June, 
between – & art, and All & are.  In each case delete the carriage return (which looks 
like a space back in the Body pane) and substitute a single space (don’t worry that it 
looks like nothing is changing).  Keep checking using the Preview button as 
necessary.  
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15. Finally, when the preview is satisfactory, click on the Save button.  You should see 

something like this: 
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4.  informing those who need to know 
 
Once the order of service is complete and the website has been updated it’s time to inform 
the people who need to know.  These are (see 5. contacts for email addresses): 
 
Mario Gehring posts printed order of service at the church door 
Gary Goodman 1st choice for photocopying 
Janet Shaner  2nd choice for photocopying 
minister  as a courtesy 
organists  both Deirde Kraege and Melody Suter 
   attach .doc file for Melody Suter, which can be spoken by her PC 
 
As a reminder, Gary’s copying deadline is Thursday morning, as early as possible. 
 
There’s no rota for photocopying, so we rely on deputising.  If Gary’s going on holiday, he 
will inform us in advance.  Otherwise if he can’t do it, he’ll email back to say so.  Janet will 
do the same.  If neither of them is available, as a last resort, the minister may be make 
copies at the church.  If Mario isn’t around, usually the minister can post the order at the 
church door. 
 
I usually send out an email like this on Thursday evening: 
 

 
 
In the unlikely event you get negative responses from both Gary and Janet, you now have 
to contact the minister to make sure that he can make the copies. 
 
Feel free to cc Ross Bennie (see 5. contacts) for the first few orders until you get the hang 
of it.   
 
And don’t hesitate to email or call Ross (076 502 61 03) if anything in this document isn’t 
clear. 
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5.  contacts 
 
These are the people you’ll typically be in contact with when preparing the order of service: 
 
Ross Bennie   rosmor@mac.com   OoS team coordinator 

Brian d’Entremont  brian@dentremont.us  webmaster 

Karma Fussell  kfussell@me.com   OoS team member 

Mario Gehring  mario.j.gehring@gmail.com posts OoS at church door 

Susan Giddons  susan.giddons@sunrise.ch  Cornerstone editor 

Alice Goodman  alice.goodman@sunrise.ch  Sunday school / youth group 

Gary Goodman  gary.goody@bluewin.ch  1st choice photocopy person 

Deirdre Kraege  deirdre.kraege@gmail.com  organist 

Ian McDonald  minister@scotskirklausanne.ch Scots Kirk minister 

Sylvia McKillop  sylviamckillop@gmail.com  Bible-reader coordinator 

Morven McLean  morven@gmx.ch   OoS team member 

order of service team oos@scotskirklausanne.ch  all members of OoS team 

Jean-Noël Alex de Réland jnadereland@hotmail.fr  OoS team member 

Janet Shaner   Janet.Shaner@imd.ch  2nd choice photocopy person 

Jim Sharp   jsharp@scout.org   regular substitute minister 

Melody Suter   melaska@sunrise.ch  organist 

Susan Wood   susanwoodsmith@gmail.com  OoS team member 


